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Symbols and Abbreviations 

The following symbols and abbreviations, and others approved for the Système International d'Unités (SI), are used 
without definition in the following reports by the Divisions of Sport Fish and of Commercial Fisheries: Fishery 
Manuscripts, Fishery Data Series Reports, Fishery Management Reports, and Special Publications. All others, 
including deviations from definitions listed below, are noted in the text at first mention, as well as in the titles or 
footnotes of tables, and in figure or figure captions. 
Weights and measures (metric)  
centimeter cm 
deciliter  dL 
gram  g 
hectare ha 
kilogram kg 
kilometer km 
liter L 
meter m 
milliliter mL 
millimeter mm 
  
Weights and measures (English)  
cubic feet per second ft3/s 
foot ft 
gallon gal 
inch in 
mile mi 
nautical mile nmi 
ounce oz 
pound lb 
quart qt 
yard yd 
  
Time and temperature  
day d 
degrees Celsius °C 
degrees Fahrenheit °F 
degrees kelvin K 
hour  h 
minute min 
second s 
  
Physics and chemistry  
all atomic symbols  
alternating current AC 
ampere A 
calorie cal 
direct current DC 
hertz Hz 
horsepower hp 
hydrogen ion activity pH 
     (negative log of)  
parts per million ppm 
parts per thousand ppt, 
  ‰ 
volts V 
watts W 

General  
Alaska Administrative  
    Code AAC 
all commonly accepted  
    abbreviations e.g., Mr., Mrs., 

AM,   PM, etc. 
all commonly accepted  
    professional titles e.g., Dr., Ph.D.,  
 R.N., etc. 
at @ 
compass directions:  

east E 
north N 
south S 
west W 

copyright  
corporate suffixes:  

Company Co. 
Corporation Corp. 
Incorporated Inc. 
Limited Ltd. 

District of Columbia D.C. 
et alii (and others)  et al. 
et cetera (and so forth) etc. 
exempli gratia  
    (for example) e.g. 
Federal Information  
    Code FIC 
id est (that is) i.e. 
latitude or longitude lat. or long. 
monetary symbols 
     (U.S.) $, ¢ 
months (tables and 
     figures): first three  
     letters Jan,...,Dec 
registered trademark  
trademark  
United States 
    (adjective) U.S. 
United States of  
    America (noun) USA 
U.S.C. United States 

Code 
U.S. state use two-letter 

abbreviations 
(e.g., AK, WA) 

Mathematics, statistics 
all standard mathematical 
    signs, symbols and  
    abbreviations  
alternate hypothesis HA 
base of natural logarithm e 
catch per unit effort CPUE 
coefficient of variation CV 
common test statistics (F, t, 2, etc.) 
confidence interval CI 
correlation coefficient  
   (multiple) R  
correlation coefficient 
    (simple) r  
covariance cov 
degree (angular ) ° 
degrees of freedom df 
expected value E 
greater than > 
greater than or equal to  
harvest per unit effort HPUE 
less than < 
less than or equal to  
logarithm (natural) ln 
logarithm (base 10) log 
logarithm (specify base) log2,  etc. 
minute (angular) ' 
not significant NS 
null hypothesis HO 
percent % 
probability P 
probability of a type I error  
   (rejection of the null 
    hypothesis when true)  
probability of a type II error  
   (acceptance of the null  
    hypothesis when false)  
second (angular) " 
standard deviation SD 
standard error SE 
variance  
     population Var 
     sample var 
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PURPOSE 

DIDSON (Dual-frequency Identification Sonar) is used annually to estimate sockeye salmon 
(Oncorhynchus nerka) escapement into the Kenai and Kasilof rivers of Upper Cook Inlet (UCI) 
Alaska (Figure 1).  “Escapement” refers to estimates of the number of salmon, by species, 
migrating upstream to spawn past a fixed point on the river.  When any number of salmon are 
harvested upstream of the enumeration point, such as in sport fishing, the number of fish that 
survive to spawn will be less than the escapement calculated at the end of the season.  
Escapement estimates of sockeye salmon are used to manage for maximum sustained yield of 
UCI salmon stocks.  Escapement goals considering both biological and allocative issues have 
been established and revised by the Alaska Board of Fisheries since the late 1970s and early 
1980s.  Alaska Department of Fish and Game (ADF&G) manage the Kenai and Kasilof rivers 
inriver goals dependent upon forecasts and daily inseason evaluations of run strength.  The 
current (2011) inriver escapement goal for the Kenai River is 900,000–1,100,000 if the return 
estimate is <2,300,000; 1,000,000–1,200,000 for a return of 2,300,000–4,600,000; and 
1,100,000–1,350,000 fish for a return 4,600,000 (Shields and Dupuis 2012).  The Kasilof River 
optimal escapement goal (OEG) is 160,000–390,000 (Fair et al. 2013).  

Fish wheels capture returning salmon for 1) species apportionment 2) to estimate age, length, and 
sex composition of the sockeye salmon escapement for each river and 3) collect genetic samples 
as needed.   Historical escapement data for the Kenai and Kasilof rivers (Table 1) is provided in 
yearly Regional Information and Fishery Data Series reports as exhibited by Westerman and 
Willette (2013).  This plan outlines how sonar, sampling and logistical operations will be 
conducted for each of these sonar enumeration sites. 

Key words: DIDSON, sockeye salmon, Oncorhynchus nerka, Upper Cook Inlet, escapement, 
acoustic assessment, Kenai River, Kasilof River, riverine sonar, fisheries sonar, fish wheel. 

Background 
The Kenai River is a glacially occluded river that drains approximately 5,200 km2 of the western 
Kenai Peninsula and is the major sockeye salmon producing watershed in Cook Inlet.  It is also a 
major producing system for coho salmon (Oncorhynchus kisutch), pink salmon (O. gorbuscha), 
and Chinook salmon (O. tshawytscha).  Since 1968, sonar operations for enumerating sockeye 
salmon runs have been conducted annually at a site 32 km (RM 19.1) upstream from the river 
mouth (Namvedt et al. 1977; Davis 1971).  Various combinations of Bendix Corp. sonar 
counters have been used to enumerate escapement.  Bendix sonar in Upper Cook Inlet was 
eventually replaced with DIDSON beginning in 2007 (Belcher et al. 2001, 2002).  Sockeye 
salmon sampling has been conducted annually since 1966, establishing a long term historical age 
composition database.   

Originating from Tustumena Lake, the Kasilof River drains 190 km2 of the east/central Kenai 
Peninsula.  A small run of sockeye salmon enters the river between late May and mid-June, with 
a second larger escapement (200,000–300,000) entering between late June and early August.   

Kasilof inseason escapement enumeration in the 1960s and 1970s was limited by the glacial 
nature of the river and Tustumena Lake.  To monitor the escapement, test fishing at the mouth of 
the river was conducted to sample the stock for age, weight, and length and sex analysis.  In the 
early years of sonar operations, surveys provided an index of reliability of the sonar generated 
escapement counts.  The testing, modifying and use of Bendix sonar counters for management 
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purposes began in 1968 and was conducted annually near the outlet of Tustumena Lake, 26.9 km 
(RM 16.7) upstream from Cook Inlet.  In 1983 the counting site was relocated nearer Cook Inlet 
to 12.4 km (RM 7.7), adjacent to the Sterling highway bridge.  Between 2007 and 2009, 
comparison tests were conducted between DIDSON and Bendix units and by 2010, DIDSON 
replaced the Bendix counters.   

OBJECTIVES 

Annual objectives of these studies: 

1. Estimate the daily and seasonal abundance of sockeye salmon into the Kenai and Kasilof 
rivers at each sonar site such that the seasonal estimate is within 10% of the true value 
95% of the time. 

2. Estimate the age and sex compositions and the mean length of each age class in the 
sockeye salmon run passing each sonar site such that the estimates are within 5% of the 
true value 90% of the time.   
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Figure 1.– Map showing location of the Kenai and Kasilof rivers sonar sites used to enumerate the 

sockeye salmon escapement into Upper Cook Inlet tributaries.  
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Table 1.–Sockeye salmon escapement estimates (Bendix and DIDSON) for the Kenai and Kasilof 
rivers 1978–2015. 

    Kenai R.a   Kasilof R.b 
Year Bendix DIDSON Bendix DIDSON 
1978 398,900 ND 116,600 ND 
1979 285,020 412,978 152,179 ND 
1980 464,038 667,458 184,260 ND 
1981 407,639 575,848 256,625 ND 
1982 619,831 809,173 180,239 ND 
1983 630,340 866,455 210,271 215,731 
1984 344,571 481,473 231,685 238,413 
1985 502,820 680,897 505,049 512,827 
1986 501,157 645,906 275,963 283,054 
1987 1,596,871 2,245,615 249,250 256,707 
1988 1,021,469 1,356,958 204,000c 204,336 
1989 1,599,959 2,295,576 158,206 164,952 
1990 659,520 950,358 144,136 147,663 
1991 647,597 954,843 238,269 233,646 
1992 994,798 1,429,864 184,178 188,819 
1993 813,617 1,134,922 149,939 151,801 
1994 1,003,446 1,412,047 205,117 218,826 
1995  630,447 884,922 204,935 202,428 
1996  797,847 1,129,274 249,944 264,511 
1997  1,064,818 1,512,733 266,025 263,780 
1998  767,558 1,084,996 273,213 259,045 
1999  803,379 1,137,001 312,587 312,481 
2000  624,578 900,700 256,053 263,631 
2001  650,036 906,333 307,570 318,735 
2002  957,924 1,339,682 226,682 235,731 
2003  1,181,309 1,656,026 359,633 353,526 
2004  1,385,981 1,945,383 577,581 523,653 
2005  1,376,452 1,908,821 348,012 360,065 
2006  1,499,692 2,064,728 368,092 389,645 
2007  867,572 1,229,945 336,866 365,184 
2008  614,946 917,139 301,469 327,018 
2009  745,170 1,090,055 297,125 326,285 
2010  970,662 1,334,769 267,013 295,265 
2011  ND 1,599,217 ND 245,721 
2012  ND 1,581,555 ND 374,523 
2013 ND 1,359,893 ND 489,654 
2014 ND 1,520,340 ND 440,192 
2015 ND 1,709,051 ND 470,677 
Note: Bendix counts were converted to DIDSON estimates (equivalents) for Kenai (1979–2006) and Kasilof rivers 
(1983–2007).  Estimates after these dates are actual DIDSON generated estimates. 
a Counting began 22 June, 1978–1987, and 1 July (1988–present). 
b Includes counts or estimates prior to 15 June (1978–1988) and post enumeration estimates (1981–1986). 
c Combined counts from weirs on Bear and Glacier Flat Creeks and surveys of remaining spawning streams. 
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METHODS 

FIELD OPERATIONS 

Acoustic Sampling 
Crews are responsible for maintenance and operation of sonar and fish wheel equipment.  Sonar 
crews may also be responsible for daily collection of age, sex and length (ASL) data from 
samples of captured sockeye salmon when Catch and Escapement sampling crews are not 
available. Enumeration begins on July 1 for Kenai River and June 15 for Kasilof River.  Unless 
extenuating circumstances dictate otherwise, counting operations at each of the sites may cease 
when the daily escapement of sockeye salmon is ≤1% of the total escapement for three 
consecutive days.  The 1% criteria will not apply for the Kasilof and Kenai rivers until after the 
cessation of commercial fishing.   

For both rivers, the DIDSON alternates between one of 2 frequencies, one of 1.8 MHz with an 
acoustic beam consisting of 96, 0.3° x 14° beams and a range limit of 10 m, and the other of 1.1 
MHz with an acoustic beam consisting of 48, 0.4° x 14° beams and a range limit of 30 m.  The 
range limit is extended on the north bank of the Kenai River by installing a unique lens on the 
DIDSON unit. The river channels, bank to bank, will not be completely ensonified with these 
range limits, but will encompass the expected traveling path of sockeye salmon for each river.  
The nearshore files, set at high frequency, will usually be recorded at 8 frames per second while 
the offshore files (low frequency) recorded at 6 frames per second.  The pulse length of the 
DIDSON makes it difficult to field-test target strengths (TS); however, a 38.1 mm calibration 
sphere was clearly seen in DIDSON images from early field tests (Maxwell and Gove 2007).  
The TS of the sphere is theoretically between -38 dB and -39 dB for each frequency at a water 
temperature of 9° C. 

Schematics which outline cables, batteries and power cords will be used to hook up all 
equipment (Appendix A).  DIDSON transducers will be mounted on appropriate stands in about 
0.6 m of water and ~15 cm above the bottom in a horizontal side-looking position on each bank 
(Figure 2).  Transducers will be placed 1–1.5 m from the offshore end and immediately upstream 
of a short weir, which will extend approximately 3–6 m into the river.  An automated rotator 
coupled with an attitude sensor will be used to assure proper aim once the transducer is 
deployed.  The aiming protocol of Maxwell and Smith (2007) is used as a guideline to determine 
the best aim for each river. Silt buildup behind the DIDSON lens is a problem, so lenses will be 
cleaned at least once a week on the Kenai and Kasilof rivers to maintain signal strength integrity 
and visual acuity. 

Operation of sonar will follow steps as outlined in the DIDSON manual (2008) and summarized 
in this operational plan (Appendix B).  In effect, DIDSON is comparative to a counting tower, 
allowing DIDSON’s video like images to be manually counted on a computer screen.  DIDSON 
produces black and white sonogram-like video images of swimming fish.  In these videos, fish 
are seen as moving or, “swimming” across a predominantly static background or river substrate.  
To date, trial auto-counting methods for enumerating moving fish images have not been very 
accurate; therefore, the video-like DIDSON images of individual fish will be manually counted 
with a tally whacker from a computer screen (Faulkner and Maxwell 2015). 

DIDSON units operate on both banks of each river 24 hours per day and once each hour, two 10 
min image files of fish passage within ranges of 1–10 m and 10–20 or 10–30 m from shore 
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depending on fish distribution will be recorded (Figure 3).  Laptop computers collect data in a 
DIDSON video file and backed it up on 1 TB external hard drives.  Technicians play back each 
image file containing a video recording, and count all migrating fish observed with 2 tally 
whackers, 1 for fish swimming upstream and 1 for fish swimming downstream.  Counts will be 
entered into an excel spreadsheet, which automatically calculates hourly and daily totals.  
Resident fish species or holding salmon are ignored as only migrating salmon are enumerated for 
escapement purposes.  Fish images which are substantially larger than average salmonid images 
and which are outside the immediate migration pattern are likely Chinook salmon and are not 
included in the daily count.   

To process and count the raw images as quickly and accurately as possible, a DIDSON 
background subtraction algorithm will often be used to view the images of fish against a black 
background.  For counting purposes and to produce the best contrast and to ensure counting ease 
and accuracy, an initial intensity setting of 40 dB and threshold of 4–5 dB will be recommended.  
Playback frame rates will vary from 8 to 30 frames second, depending on fish densities and the 
ability to accurately differentiate fish images by individual observers.  Intensity and threshold 
levels used by technicians will be relatively constant with small variations between individuals 
for personal preference.  Hourly fish counts from image files will be continuously compiled and 
frequently relayed to management biologists for inseason and timely commercial fishery 
applications.   

 
Figure 2.–DIDSON transducer (black unit) and rotator mount (top). 
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Figure 3.–Computer image of a DIDSON frame indicating fish at 7 m and 10–12 m. 

 

Fish Wheel Sampling 
Fish wheels will be operated on the north banks of the Kenai and Kasilof rivers to catch fish for 
apportionment purposes and to collect ASL information from sockeye salmon (Tables 2, 3).  
Installation and operation for fish wheels will follow step by step procedures with slight 
modifications depending upon site specific needs (Appendix C). 

 
Table 2.–Average age composition (%) and mean length of UCI sockeye salmon sampled from fish 

wheels in the Kenai and Kasilof rivers. 

% Age Composition 

Age Class 
    1.1 1.2 1.3 1.4 2.1 2.2 2.3 Other 
Kenai River 
Average age (1970–2011)  0.4 15.4 55.0 0.8 1.7 10.4 15.4 ~1.0 
Average length (mm)   489 576   508 576 
 
Kasilof River    
Average age (1969–2011)  0.3 32.8 35.4 0.2 0.3 20.9 9.2 <1.0 
Average length (mm)   473 541   474 536 
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Table 3.–Historic average species composition of fish wheel catches and CPUE’s (catch per hour) by species. 

        Average catch by species (%)   CPUE by species Total 
Kenai River north bank Sockeye Pink Chum Coho Chinook   Sockeye  Pink  Chum Coho  Chinook CPUE 
Odd years  97.7 0.8 0.0 1.0 0.4  7.2 0.1 0.0 0.1 0.0 7.4 
Even years  90.1 7.5 0.0 1.9 0.5  6.7 0.6 0.0 0.1 0.0 7.5 
Average: (1978–2012) 93.5 4.5 0.0 1.5 0.5  5.7 0.5 0.0 0.1 0.0 7.4 
Minimum: (1978–2012) 29.4 0.0 0.0 0.1 0.0  0.4 0.0 0.0 0.0 0.0 0.4 
Maximum: (1978–2012) 99.8 69.8 0.0 7.3 2.2  22.1 2.2 0.0 0.8 0.2 23.0 
SD: (1978–2012) 12.3 12.0 0.0 1.6 0.5   5.8 0.5 0.0 0.2 0.0 6.1 
              
Kasilof River north bank             
Average: (1983–2012) 96.6 1.5 0.0 0.1 1.8  3.6 0.1 0.0 0.0 0.1 3.8 
Minimum: (1983–2012) 92.1 0.2 0.0 0.0 0.1  1.6 0.0 0.0 0.0 0.0 1.7 
Maximum: (1983–2012) 99.4 5.1 0.0 1.4 5.2  11.7 0.2 0.0 0.0 0.2 12.0 
SD: (1983–2012) 1.8 1.1 0.0 0.3 1.2   2.1 0.0 0.0 0.0 0.0 2.1 
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All fish wheels are of similar design consisting of framework that supports aluminum or foam-
filled plastic floats, an axle and live box (Figure 4).  Partitioned, custom made aluminum floats, 
prevents the fish wheel from sinking should a float develop a leak.  Two baskets and 2 paddles 
are mounted to the axle at 90° angles to each other that rotate in the river.  As the axle rotates in 
the current, baskets scoop fish from the river, dropping them in a live box mounted to the outside 
of the fish wheel frame.  The baskets are fitted with 2–2.5 in (5–6 cm) tarred netting and a slide, 
which funnel the fish toward an opening in the basket netting and into the live box.  The live box 
is mostly submerged in the river, where constant flows of freshwater keep fish alive and 
vigorous.  All fish wheels are anchored to shore using a boom (either a wooden or steel 4 x 4) to 
station the wheel in current deep and fast enough to allow the axle to turn.  The baskets rotate as 
close to the bottom as possible where most fish migrate.  Cables or rope secure the front end to 
shore and keep the fish wheel parallel to the current.  Spinning speed of the fish wheel should 
range between 2 and 5 revolutions per minute (rpm) with optimum speed at 3–4 rpm (any slower 
or faster will reduce its effectiveness).  A short weir, 3–6 m wide (depending on river) with 
pickets spaced no more that 7 or 8 cm apart, extend from shore diverting near shore fish toward 
the spinning baskets.  These weirs are either aligned with or just downstream of the axle or 
immediately below the fish wheel (near shore) float. 

Age, Sex and Length Sampling 
Sample sizes for estimating ASL compositions will be 0.1% of the previous day’s sockeye 
salmon escapement estimate on the Kenai River and 0.2% on the Kasilof River (Appendix C).  A 
single scale for age analysis will be collected from a preferred area on the left side of each fish, 
on a line between the posterior edge of the dorsal fin and anterior portion of the anal fin about 2 
or 3 scale rows above the lateral line.  If the preferred area is scarred or void of scales, the scale 
will either be taken in front of the preferred area or from the same spot on the right side of the 
fish.  Lengths are measured from mid eye to fork of tail (MEFT).  Additional ASL or genetic 
data may be collected from other salmon species for comparative studies (Appendix D).  

Age and sex compositions of sockeye salmon will be estimated as a series of proportions pij 
defining a multinomial distribution:  

nnp ijij ˆ , (1) 

where n is the number in the sample and nij is the number in the sample of age i and sex j.  The 
sample variance for pik will be estimated from 

 )1()1(2  jkjkjkjk npps .         (2) 

Mean lengths of sockeye salmon will be estimated for each age and sex class, i.e. 

n

L
L

n

m
m

ij


 1 .            (3) 

The sample variance for Ljk will be estimated from 

)1()( 22  nLLs ijk .          (4) 
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Climatological Data Collection 
Water and air temperatures, water depth (staff gauge), and general weather conditions will be 
recorded at each of the sonar sites.  Turbidity or water clarity (secchi disc) will be measured in 
the Kenai and Kasilof rivers.  All data will be recorded approximately the same time every day 
and 12 hours apart if done more than once a day (Figure 5).  When moving the water depth 
gauge, the depth will be recorded before and immediately after resetting the gauge.   

Stream Surveys 
Stream survey salmon counts are important indicators of run strengths in UCI and may be 
conducted as time and available personnel allow.  When conditions allow, a foot stream survey 
may be conducted on Quartz Creek by ADF&G, Division of Commercial Fisheries during the 
historical peak of sockeye salmon spawning activity (late August) to assess tributary 
escapements in the upper Kenai River drainage.  All observed fish, living and dead sockeye 
salmon and other species of fish, will be counted and evidence of predation noted.  The Quartz 
Creek survey covers the lower 7.5 km of the creek starting at the Matanuska Electric Association 
substation on the Sterling Highway and ends at Kenai Lake.  A stream survey (foot) of the lower 
2.5–3.0 km of Ptarmigan Creek may also be conducted by Division of Commercial Fisheries. 

DATA ANALYSIS 

Estimating Total Fish Passage 
For each bank separately, all fish images on a computer screen will be counted with a tally 
whacker for each near shore (n) and offshore (o) 10-minute file, differentiating upstream (nu) from 
downstream (nd) swimming fish.  Counts will be entered into excel spreadsheets where the 
number of salmon migrating upstream on bank b in hour h will be estimated by 

10
)()(

60 )()()()( odoundnu
bh

nnnn
N


 .     (5) 

All 24 hourly estimates for a calendar day will be summed to estimate daily fish passage (Nbd) 
for each bank (b), i.e. 





24

1h
bhbd NN ,      (6) 

Then, the fish passage estimates for both banks will be summed to estimate the total daily fish 
passage (Nd).    

Estimating Missing Data 
When temporary equipment failure or intentional shutdowns for maintenance result in missing 
data for a given bank, hourly fish passage for any given hour, yx , will be estimated by averaging 
valid counts for the same bank in adjoining hours, usually 1 hour before and 1 hour after yx .  
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where: 
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  )( xzs = sum of all valid counts in adjoining hours of yx , (xz), and 

 )( xzn  = number of valid adjoining hours of yx , (xz). 

If a sonar unit does not operate for more than a day due to electronic problems or high water, a 
ratio of fish passage estimates between banks will be used to estimate missing daily data.  For 
example, if the daily estimate for bank 1 was unobtainable, daily fish passage will be estimated 
from the ratio of the fish passage between banks for the previous 3 days and the fish passage on 
the opposite bank, i.e. 

d
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 .     (8) 

Estimating Salmon Species Composition 
The primary objective of the project is to estimate sockeye salmon escapement, but escapement 
estimates will also be reported for coho, pink and chum salmon without variances.  Fish wheel 
catches will be used to apportion total daily sonar counts to species. Kenai or Kasilof river sonar 
counts will not be apportioned until the species composition of the daily fish wheel catch is at 
least 5% pink and/or coho salmon and the evidence of a trend is obvious.  This guideline was 
developed to accommodate situations where run timing of sockeye and pink salmon (and 
sometimes coho salmon) overlap, usually during even-numbered years.   

At the Kenai and Kasilof rivers, the daily escapement of each salmon species Nsd, will be 
estimated by multiplying the total daily fish passage estimate (Nd) by the proportion of each 
species captured in the fish wheels (ps), i.e., 

                                                           sdsd pNN  .             (9) 

When the fish wheel catch is low (<20 fish) or does not operate during a 24-h period, the catches 
from the 2 previous days will be combined with the low catch to estimate ps. The abundances of 
non-salmon in fish wheel catches, such as rainbow trout (O. mykiss) and whitefish (Coregonus 
spp.), are typically small (<1%) so these species will not be apportioned from the total sonar 
count.   

A simple method to observe relative abundance and fish wheel catch efficiency of any given fish 
species will be determined by calculating catch per unit effort (CPUE).   

e
cCPUE        (10) 

where: 

 c = total number of fish caught 

 e = total number of hours each fish wheel was fished  
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Figure 4.–Typical fish wheel installation, Kenai River fish wheel and weir.    

 

Variance of Sockeye Passage Estimates 
The variance of the sockeye salmon passage estimate on bank b and day d, due to systematic 
sampling in time and adjustments for missing data, will be approximated using Wolter’s (1985) 
successive difference method, i.e. 
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where m is the number of hourly counts in a day (usually 24) and j is the hourly sampling 
expansion factor (usually 60 minutes/10 minutes=6). If sonar count data are missing in a day, the 
sample size m will be adjusted accordingly.  The total variance on day d will be estimated by 
summing the variances from the 2 banks.  

When total daily fish passage estimates are apportioned to species using fish wheel catches, the 
daily variance will be estimated as 

                                      )()()()(ˆˆ 22
dsdssdsd NVpVNVppVNNV


                                (12)   

Goodman (1960).  The variance of the sockeye salmon passage estimate for the season will be 
estimated by summing the daily variances.  The 95% confidence intervals on the total sockeye 
salmon passage estimate will be estimated as described by Zar (1984). 
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Evaluation of Observer Variability 
Previous studies by Westerman and Willette (2011) indicate that differences between observers 
increases for rivers with higher densities, especially for the Kenai River.  Each observer will 
recount between 24 and 34 (~30), 10 min DIDSON subsample files which were recorded during 
or near the peaks of the Kenai and Kasilof river runs in previous years.  Observer counts will be 
stratified for every 100 fish based on averages (Equation 8) of each sample (100–199, 200–299, 
etc.), then averages determined from these strata will be compared against those of each 
observer. 

For each river, the number of fish counted by each observer per subsample is compared against 
the crew average for that subsample: 

i

i
i n

f
f 
       (13) 

where: 

 if     = average number of fish for a given subsample (i), 

  if = sum of fish counts of all observers for a given subsample, and 

 in      = number of observers for a given subsample. 

The observer average of all subsample counts (30) will also be compared to the crew average of 
all subsamples (30x): 

x
f

F o
o 30


       (14) 

where: 

 oF     = average of all observers, and 

  of = sum of all subsample counts for all observers. 

The standard deviation (SD) will be used as a measure of error between observers, and 
correlation (R2) values will be used to indicate the relationship between an individual’s 
subsample count and the average for the crew.  These values will be compared against the 
averages for each sample and for all samples (n = 30).  The goal of these recounts is to achieve 
an observer to average relationship as close to 1:1 as possible (R2≥0.95) for each file. 
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     Environmental Data          1-sunny     4-m.cloudy (> 50% ) partly sunny 

  River:        Year        2-sunny, hazy  5-overcast   
                     3-p. cloudy (< 50%) mostly sunny 6-rain   
                  H2O Velocity-  Distance from shore and Depth  
    Level Water Air Cloud Wind Wind         

Date Time (Feet) 
Temp 
(C) 

Temp 
(C) 

Cover
* Dir. Speed 

Turbidity 
(in)         Comments 

                   

                  

                  

                   

                            

                            

                            

                            

                            

                            

                            

                            

                            

                          

                            

                            

                           
Figure 5.–Environmental form used to record temperature, turbidity, water depth, etc. 
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SCHEDULE AND DELIVERABLES 

The annual schedule of activities is as follows: 

 June 1–August 31 Kasilof River preparation, operation, maintenance 
 June 15~August 15 Kasilof sonar operational, data collected, ASL sampling 
  

June1–August 31 Kenai River preparation, operation, maintenance 
July 1~August 20 Kenai sonar operational, data collected, ASL sampling  
 
October 31  Field data error checked  

  
January 1  Data is summarized into tables for report preparation 

 

RESPONSIBILITIES 

Project Fisheries Biologist III Supervise Commercial Fisheries research projects for 
Upper Cook Inlet 

 
Project Fisheries Biologist II  Supervise escapement projects, assist in field as needed 

 
Project Fisheries Biologist I (2) Crew leader, supervise daily activities and training of new  
     personnel in sonar procedures  and assist in field as needed.  
     Summarize the daily enumeration results.  Report results to 
     Soldotna daily. 

Fish and Wildlife Tech III (2)  Operate and follow sonar procedures in the field.    
     Supervise and train Fish and Wildlife Tech II’s when  
     necessary.  Act as field crew leader when necessary. 

Fish and Wildlife Tech II (4)  Operate and follow daily sonar procedures. 

Fisheries Biologist III   DIDSON support and research. 

Fisheries Biologist II   DIDSON field support. 
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APPENDIX A: DIDSON CONNECTIONS 
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Appendix A 1.–DIDSON schematic showing a generator as a power source.  This setup is also applicable to an AC power source used on the 

Kenai River south bank.  Not shown is DVD burner and external hard drive, which connects to the power strip and computer. 
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Appendix A 2.–DIDSON schematic showing batteries as a main power source and a DVD burner and external hard drive interfaced with the 

laptop. 
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Appendix A 3.–DIDSON schematic for Kasilof River north bank and Kenai River north bank. 
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APPENDIX B: DIDSON OPERATION AND DAILY 

PROCEDURES 

 

 



  

22 

 

Appendix B 1.–Step by step DIDSON operation and daily procedures. 

Connecting the parts 
1. Power switch on the topside box must be OFF. 
2. Connect the black sonar cable between the DIDSON and topside box. 
3. Connect the (blue) Ethernet cable between the topside box “PC” port and the computer 

Ethernet port. 
4. Connect the 24 VDC power supply to an AC power outlet and to the topside box power 

supply port. 

Startup 
Set the DIDSON in the water.  The DIDSON Operation Handbook will be available at all 
sites and is recommended reading. 

1. Check that the DIDSON Box, external Drive, computer and power strip is OFF. 
2. Turn ON Generator. 
3. Turn ON power strip 
4. Turn ON topside box.    (O is off  and   –  is on);  allow 1–2 minutes for connections 
5. (Turn on external hard drive when moving data from the computer to storage). 
6. Turn ON computer 
7. Once all units are on, connect the USB port (white cord) to the back of the computer and 

plug in the fire wire to the port on the RH side of the computer 
8. Double click on the DIDSON icon, located on the right side of the screen.  Be sure 

DIDSON program is set at high priority in the task manager; right click 
Task>Prioritize>DIDSON. 

a. It could take a minute for the computer screen to indicate a connection indicated at 
the bottom of the screen.  A red TIMER block on the lower right of the sonar 
image will also be visible.  If the TIMER is not visible, go to:  

9. If the program is in demo mode, click Edit>Mode>Uncheck Demo. 
10. Click Image and check the Timer Recorder and close.  If it still isn’t visible, be sure the 

computer is connected or call for assistance.  

Data Collection and Setup 
The following parameters will be found on the left side of the screen under Sonar Controls.   

1. Make sure Auto Freq and Auto Rate are checked in Sonar Controls. 
2. Click the up or down arrow and set Window Start and Window Length (range).   

a. When the maximum range exceeds 15 m, the sonar changes from 1.8 MHz (high 
frequency) to 1.1 MHz (low frequency).   

3. Click the up or down arrow and set frame rate, (red square will blink if too high). 
4. In the Display Controls, increase or decrease Threshold or Intensity effects system 

noise and brightness. 
5. Click Image>Capture>Timer Data entry:  If already set, clear and set the time sample 

to be collected, set date and save. 
6. Check written text for accuracy then click OK.  Set up for next strata and repeat step 2 

above.  
7. To turn on and off recording at different times each day; 

a. Exit DIDSON (save settings) and reopen.   
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b. Be sure DIDSON program is set at high priority in the task manager on the 
computer.  Right click, Task, prioritize, DIDSON. 

c. Click Image>Capture>Timer Recording (Red Timer flag should appear in 
window).  

d. Go to Edit>Header ID.  Type name of River, NB or SB (Kasilof NB).   
e. Click once (or point the arrow) on the small, green arrow located on the bar at the 

bottom right of the screen.  Three lines should appear which will confirm 
connections to all the appropriate gizmos.  Two lines will indicate the F Drive is 
active (“Stop Maxter…F drive”) and the sensor is active (“…US485TB…”) 

Recording Data 
1. Click DIDSON icon. 
2. Before recording data (within the DIDSON program) 

a. Click File/Set Save Dir/Name. 
b. Navigate to the DIDSON folder where the data will be filed or create a new folder 

if necessary, before beginning this step; name the folder DIDSON. 
c. Leave the default name, click Save. 
d. Replace HHMMSS etc. - NO 
e. Append frequency – YES 

3. DIDSON settings for recording – Make sure these are correct!  There are some automatic 
defaults which may change some of your numbers as you enter new ones.  Example: the 
frame rate may change after you enter the intensity and threshold.  The last recording 
remains on the screen after the recording is finished; this is the active, connected 
DIDSON.  Most observers prefer to see the onshore active, connected view between 
recordings; therefore, it is the second stratum, or last recording event. 

Timer Data Entry (automatic recording) 
1. Set up the parameters or sonar controls (left side of DIDSON screen) for the 1st stratum to 

be recorded. 
2. Go to Image / Capture / Timer Data Entry. 
3. Click hourly. Set time to the next top of the hour and date to be sampled. 
4. Duration = 10 
5. Save.  Click OK. 
6. Change the (sonar controls) window start, length and frame rate to the 2nd stratum.   
7. Go to Image / Capture / Timer Data Entry. 
8. Set time to 15 min after top of the hour. 
9. Duration = 10 
10. Save.  Click OK. 
11. Go to Image / Capture / check Timer Recording.  The red Timer box should appear in 

the bottom right corner of the window.       

Below are examples of settings used at Kenai.  Settings could be slightly different at other 
sites. 

 South Bank 
  1st stratum:  low freq, offshore 

 Frame Rate = 5 frames/sec 
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 Receiver Gain = 40 dB  
 Window Start = 10 m 
 Window Length = 20 m 
 Focus is automatic    
 Intensity (90) and  
 Threshold (13)  

  2nd stratum:  high freq, onshore 

 Frame Rate = 8 frames/sec 
 Receiver Gain = 40 dB  
 Window Start = 0.4 m  
 Window Length = 10 m 
 Focus is automatic    
 Intensity (90) and  
 Threshold (13)  

 North Bank 
 1st stratum/low freq/offshore        

 Frame Rate = 4 frames/sec 
 Receiver Gain = 30 dB  
 Window Start = 10 m 
 Window Length = 30  
 Focus is automatic    
 Intensity (90) and  
 Threshold (13)  

2nd stratum/high freq/onshore   

 Frame Rate = 8 frames/sec 
 Receiver Gain = 30 dB  
 Window Start = 0.4 m 
 Window Length = 10  
 Focus is automatic    
 Intensity (90) and  
 Threshold (13)  
Note: smooth and auto freq boxes may be checked, but not critical 

Subsample counts 
For every hour of fish passage, DIDSON records 2, 10 minute subsamples of fish passing 
between 0.4 and 10 m (high frequency) and between 10 m and 20–30 m (low frequency) 
from the transducer.  

1. Always minimize but do not close the DIDSON window that displays for recording.  (Be 
sure DIDSON v5.25 is loaded onto your computer – see Maxwell)  

2. Click on the DIDSON icon that brings the program into demo mode (Edit / Demo Mode 
checked). Click off Timer if it appears in the window (Image / Timer Recording not 
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checked). To open the first file, go to File / Open / then navigate to C:/Kenai (year) or 
Kasilof or Yentna NB (or SB) followed by year / DIDSON data files.   

3. Open the desired file File>Open (i.e. 2015-07-25_130000_HF.ddf).   
4. Before the counting can begin, set the parameters on display to the left of the screen.    

Increase or decrease the frame rate according to passage density and at a rate that is 
easiest to view and count.  Use these suggested rates as a guideline;  

a. >300 fish/10min, use ~6–8 fps;  
b. At 100–300 fish/10min, use ~16–20 fps;  
c. At 0–100 fish/10min, use ~24–30+ fps; 

5. Slower frame rates may be needed for near shore files because of a greater abundance 
and compactness of fish.  

6. The intensity and threshold setting is important, it will make the fish images more visible 
and easier to count.  Intensity should be set by clicking and holding on the slide and 
moving the slide one way or the other. Set intensity at or near 18 and Threshold to 4, 
adjusting to each person’s preference.  Once the intensity, threshold and frame rate are 
set, you shouldn’t need to adjust anything unless you close out of the DIDSON program 
and return.  Check these criteria after each file has been counted nonetheless.  

7. If the background complicates the ability to see fish and count, remove the background 
from view by clicking the background subtraction button or go to the menu and click 
Processing/Background subtraction. 

8. Note the start time and date on the field form (Figure B1-1), and record intensity, 
threshold and frame rate on the data sheet under comments.      

9. To start processing the file, click the blue, right-hand triangle at the top of the window.  
The fish will appear as moving, fish-like figures on the screen and will appear bigger 
with high frequency, smaller with low frequency.  (Low frequency is used for longer 
range monitoring.)  Count all visible fish when starting the files except but those that are 
not 100% visible while leaving the “cone of visibility”.  Conversely when the file stops, 
count all visible fish but not those just entering the screen and are only partly visible.  
Remember, these files contain 10 minutes of passage, no more and no less.   

10. Valid fish counts:  Count upstream and downstream fish using a tally counter for each 
direction.    DO NOT count fish that are obviously holding (or are the size of Chinook 
salmon for those sites that do not apportion) until that fish leaves the screen.  For valid 
near shore counts; enumerate all fish that enter from the top of the screen and exit 
upstream.  We will consider these nearshore fish.  Count all fish that exit the screen 
through the top only if they are moving upstream.  This may be a judgment call; don’t 
count if the fish looks as if it was turning and could possibly move downstream by 
exiting through the top.   Use your best judgment.  When the file starts or ends, count 
those fish on the screen that were definitely moving but not partials of fish just entering 
the beam-don’t count heads, count entire bodies.  For valid offshore counts; follow the 
same guideline already provided except do not count fish that fully exit through the 
bottom.  These fish will be considered nearshore fish although they spent time in the 
offshore zone. Remember, we are counting fish in the nearshore that enter from offshore.   
In some rivers, Chinook should be ignored, especially if they spawn in this section.     

11. Record counts as upstream or down, depending on near shore or off shore movement as 
shown in Figure B1-1. 
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12. To count the next file click on the forward arrow on the tool bar and the next file will 
appear.  The file name will appear at the top of the window, make sure it’s the next file 
you want to count. 

13. To stop; click the blue block  
14. To rewind, click the left-hand triangle or arrow   
15. To return to the start; click the left hand arrow with the line to its left  
16. To advance to the end, use the right-hand arrow with the line to its right.    
17. If you hold the cursor on the triangle, a small window will appear explaining the purpose 

of the icon.   
18. After each file is completely counted, record the upstream and downstream counts and 

time on the data sheet and start on the next file.   
19. To move quickly to the next file, click the right- pointed BLACK arrow in the window 

above the main image.  The next file will open and you’re ready to count again.  (The 
left-hand black arrow will open the previous file.)  

Saving data 
1. Click File/Set Save Dir/Name.    Save to DIDSON data  
2. Navigate to folder (ie; C:/Kasilof 2015/NB or SB/DIDSON data) where you want to put 

the data or create a new folder before beginning this step.   File organization and names 
must be consistent between rivers. 

3. Leave the default name, click Save.   
4. Replace HHMMSS etc. – NO      
5. Append frequency – YES 
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Bank 

 
River:     Year:   

    
    

                            
      Subsample               
  

  
Near-shore (0-10 m) Off-shore (>10 m)  File Time Total Sample Time       

Date Obs Hour Upstream Dnstream Upstream Dnstream start stop Minutes Seconds Intensity Threshold Frame Rate 
    0                       
    1                       
    2                       
    3                       
    4                       
    5                       
    6                       
    7                       
    8                       
    9                       
    10                       
    11                       
    12                       
    13                       
    14                       
    15                       
    16                       
    17                       
    18                       
    19                       
    20                       
    21                       
    22                       
    23                       

Figure B1-1.–Raw data form to record 10-minute DIDSON subsample counts.  Data will be entered into an electronic Datsum file which will 
be linked to a calculation and adjusted count worksheet. 
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External Hard Drive 
All DIDSON files will be moved to an external hard drive within 24–48 hours of recording 
to maintain adequate memory space on the computer.  Connect the external hard drive to the 
computer and plug to the power source.  A special directory letter will appear, if not, assign 
one for the external drive.  To do so; 

1. Click on START (bottom left of the screen),  
2. Then, SETTINGS,  
3. Followed by CONTROL PANEL,  
4. ADMINISTRATIVE TOOLS,  
5. COMPUTER MANAGEMENT  
6. And finally, DISK MANAGEMENT.   
7. Right click on hardware device (F drive) and assign a drive letter (use J).  {Change the 

drive title (example; Yentna DIDSON) and path, change (click 2 x) and assign the 
letter.}   

8. Close 
9. (If formatting is not necessary, skip this step)  Formatting External Drive 
10. Go to control panel 
11. Admin tools 
12. Computer management 
13. Disk management 
14. Disk 2 
15. Initial with right  
16. Right click-mark partition 
17. Perform quick format 
18. Next, next 
19. Observe formatting message and then healthy message 

Data Transfer 
There have been problems when transferring files to the external hard drive while the 
computer was recording so: DO NOT transfer data while the computer is recording.  
Also, be sure that the firewire or USB is connected between the hard drive and the computer.  
(A fire wire may not be required in some cases, be aware of this.) 

1. Turn on the hard drive and wait for it to be recognized by the computer. The hard drive 
will have its own unique letter and may vary from site to site.  

2. Create folders on the hard drive similar to those on the laptop:  example – River name & 
year/NB or SB/ (Kenai, Kasilof or Yentna 2015/NB/DIDSON data).  Add a folder for 
each bank by date (mmddyy). 

3. Scroll through data files making sure there is a file for each hour and strata.  Highlight the 
files to be moved and either cut and paste or drag to the proper hard drive folders. 

4. Check to make sure all data was copied to the hard drive. 
5. Right click the icon with the green arrow in the lower menu bar: 
6. Click the “Safe removal, Unplug or eject hardware”. 
7. On menu that pops up, select the external drive and click stop.  If the drive is not ready to 

release, because it is still in use, try again.  
8. It will say it is safe to unplug when ready. 
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9. Unplug the cable from the External drive.  
10. Click close on the Unplug or Eject Hardware window. 

Copying to Disk 
Below are 3 different instructions for copying files to disk.  Use the instructions that is best 
suited to your computer.  In all 3 cases, the external hard drive must be turned off. 

#1 - Roxio 
1. Put in a new disk 
2. Add files using Roxio, OK 
3. Direct to Disc 
4. Format 
5. Label 2015 Kenai SB 
6. Start 
7. Yes 
8. OK 
9. Explore; go to file(s) to transfer 
10. 0000–1115 or 1200–2315; only half a day will fit on a disk 
11. Highlight and drag/drop file to Roxio 
12. Make compatible 
13. Label disk; 15Ke0701 

#2 – Sony DVD Burner 
1. The external hard drive must be OFF 
2. remove firewire from external 
3. plug firewire into Sony DVD 
4. turn on Sony 
5. open Record now program 
6. click create data disk 
7. change from slim drive to Sony drive if slim drive shows up on menu list 
8. insert disk 
9. next 
10. drag files from explore go to file(s) to transfer 
11. 0000–1115 or 1200–2315; only half a day will fit on a disk 
12. Highlight and drag/drop file 
13. next 
14. observe “writing disc” 
15. observe “verifying” 
16. click done 

#3 – RecordNow 
1. Insert blank disk-one disk per day on NB 
2. RecordNow! Plus opens 
3. Drag file from explore 
4. click burn 
5. takes about 25 min/24 hrs of data 
6. click done 
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Attitude sensor settings (Geomechanics) 
1. Click Zagi33 icon/ Communications/ switch to com 3/ Continue/ Data Access/ Start.   
2. Create a new sensor file under C:/river 2015/bank/Sensor/ 
3. Click Stop & uncheck save to file 
4. Click Start 
5. Click save to file  
6. The window for directory C:/Kasilof/ NB (or SB) 2015/sensor will open.  
7. Name the new file by river abbrev, bank, _date and _ time (i.e. KeNB_070510_0800).  

File extension of .dat is automatically added. 
8. Click Save 

Attitude sensor settings (HPR) 
1. Be sure USB cable is connected. 
2. Right click green arrow icon 
3. Click safely remove hardware 
4. Check the com port the device is connected to 
5. Close 
6. Start:  Double click on the HPR icon (be sure correct port is selected).  
7. In the Upper right of the HPR box is a button or toggle, which should be red.  Click 

(double click if necessary) on the red button until it turns green.  The attitude sensor is 
operating when in the green and not operating when red.   

8. Go to File, open Log File and name the file.  Type HPR, the date (year and day) and 
military time, including the dashes and underline where shown.  Example;  HPR2015-06-
28_0950.  Save the file in a separate directory such as   >C:/KenaiSB/HPR.  Don’t add an 
extension, the program will do that automatically.  Click OPEN. 

9. Click START LOGGING and minimize the box.  (The – symbol in the little box in the 
extreme upper right corner.) 

10. Note the HPR in a log book whenever the HPR headings are checked or changed for 
reference purposes. 

11. Stop:  Stop logging to file and close. 
12. Click the green toggle, which will turn red, and close. 
13. Right click green arrow icon in bottom bar of screen, click safely remove hardware, 

select Model US485TB (com 5) and stop. 
14. Ok and close, unplug USB from computer. 
15. TROUBLE SHOOTING HPR 

a. Check all inside connections  
b. Check power  
c. Check USB connection (reconnect) and restart 
d. Check in-water connection and entire cable 

Data Summary (Datsum) 
1. The Datsum file, used in all UCI escapement projects, is a file with linked worksheets 

that summarizes hourly and daily escapements and fish wheel catches for the season.   

2. There are 2 raw writable sheets, 1 for each bank, for entering hourly subsample counts.  
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3. Linked to both the raw and adjusted sheets are 2 calculations sheets (1 per bank) for 
determining average counts (protected and not for writing).  This sheet takes missing data 
from the raw sheet as denoted by an *, calculates an average which is inserted into the 
adjusted sheet to replace the missing data. 

4. The 2 adjusted sheets, 1 per bank, (Figure B1-2) tabulate final hourly and daily estimates. 

5. Record fish wheel on/off times and catches onto the fish wheel(s) sheet (Figure B1-3).   

6. Final escapement and fish wheel catch data is automatically inserted into a single, write 
protected summary sheet (Figure B1-4).  Daily totals won’t show up in the Datsum until 
all entries are complete.   

7. Check that data is displayed on the adjusted (hourly counts) and Datsum (daily total only) 
sheets.  The data between sheets should also match each other if the formatting is correct.  
Periodically, check all formatting.  DO NOT CUT AND PASTE-this will delete 
formatting for the cut cells and cause problems with the estimates. 

8. Enter any comments about debris, sliders, large fish, etc. on the field form.  
9. Escapement and fish data needs to be completely entered sometime after midnight or 

early morning (pre 0900) 
10. The templates for each project site should have been set up and checked for proper 

formatting before taken to the field.  Start with the Datsum template for the respective 
river and save as 15KaDatsum or 15KeDatsum (15 is the year).  The template will remain 
blank but a new file will have been created and saved under the directory provided below.  
Be sure the headings and file names are complete and correct – these files will be 
analyzed by the project leader at the end of the season so file names must be in 
accordance with the instructions in this plan. 

11. Note: escapement estimates determined in the field often may not match the numbers 
tabulated and reported in the office.  This is because of a number of possibilities; 1) 
unreported corrections made in the office or the field, 2) transcription errors, 3) wrong 
data is reported, 4) escapement program rounding discrepancy (differs slightly from excel 
rounding) and 5) format glitches in any 1 of a number of excel worksheets/files.  The 
crews will report daily numbers (along with fish wheel catch data) so the project leader 
can match the data generated by the escapement program to that being reported. (Report 
only daily fish wheel catches by species and hours fished; cum fish wheel catch data does 
not have to be reported.) If the discrepancy is tens of fish, then such discrepancies are 
acceptable and can be corrected post season.  Larger discrepancies need to be 
investigated and corrected at the source.  
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ADF&G/CFMD - Upper Cook Inlet Sonar Program 

  
  

Adjusted Hourly Sonar Counts 
  

       
    

                 
  

      
  

 
Location: 21 (North) 

  
River: Kasilof Year: 2014   

  
     

  
    

  
    Near-shore (0-10 m) Off-shore (>10 m) 

 
          

    Subsample Count Subsample Count Sum Sample time DIDSON Count 
Date Hour Upstream Dnstream Upstream Dnstream NS+OS minutes seconds Hourly Daily Cum. Total Cum 
15-Jun 0 3 0 4 0 7 10 0 42 42 42 
15-Jun 1 8 0 1 0 9 10 0 54 96 96 
15-Jun 2 8 0 4 0 12 10 0 72 168 168 
15-Jun 3 5 0 5 0 10 10 0 60 228 228 
15-Jun 4 8 0 3 0 11 10 0 66 294 294 
15-Jun 5 23 1 2 0 24 10 0 144 438 438 
15-Jun 6 32 0 1 0 33 10 0 198 636 636 
15-Jun 7 11 0 0 0 11 10 0 66 702 702 
15-Jun 8 9 0 0 0 9 10 0 54 756 756 
15-Jun 9 9 0 5 0 14 10 0 84 840 840 
15-Jun 10 8 1 7 0 14 10 0 84 924 924 
15-Jun 11 9 0 4 0 13 10 0 78 1002 1002 
15-Jun 12 7 0 2 0 9 10 0 54 1056 1056 
15-Jun 13 16 0 0 0 16 10 0 96 1152 1152 
15-Jun 14 1 0 0 0 1 10 0 6 1158 1158 
15-Jun 15 8 0 2 0 10 10 0 60 1218 1218 
15-Jun 16 4 0 1 0 5 10 0 30 1248 1248 
15-Jun 17 4 0 1 0 5 10 0 30 1278 1278 
15-Jun 18 3 0 0 0 3 10 0 18 1296 1296 
15-Jun 19 11 0 0 0 11 10 0 63 1359 1359 
15-Jun 20 5 0 1 0 6 10 0 36 1395 1395 
15-Jun 21 29 0 1 0 30 10 0 180 1575 1575 
15-Jun 22 18 0 0 0 18 10 0 108 1683 1683 
15-Jun 23 4 0 1 0 5 10 0 30 1713 1713 

Figure B1-2.–Adjusted data sheet example, linked to raw data form which calculates hourly and daily escapement estimates.  The second to last 
cell, bottom right, is linked to the summary sheet, containing the final daily escapement estimate. 



  

33 

 

Missing hours 
1. DIDSON power problems often result in a failure to record image files.  Such equipment 

failure has been known to last for as long as 6-8 hours especially if the failure occurs at 
night when crews are off.  The average from 3 valid hours before and after the affected 
time will be inserted into the missing hour(s) to compensate for the missing data.   
Excessive hours of missing data may have to be adjusted postseason by the project leader 
if the number of valid counts used in the averaging is inadequate.  Environmental 
conditions can put a unit out of action for longer periods, sometimes for more than 24 
hours, which has occurred at Yentna where high water has caused temporary cessation of 
operations on one bank. If escapement estimates from a bank is missing for an entire day 
or more, then a ratio with the opposite bank (assuming opposite bank is operating 
properly) will compensate for missing data.  If both banks are out of commission for a 
day or more, escapement estimates will be determined at the area office by the project 
leader. 
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FISH WHEEL CATCH SUMMARY 

      
                  River     

     
Bank   

   
Year   

   
                  
    

Total Date    SOCKEYE        PINK        CHUM        COHO    CHINOOK OTHER (Note Sp) 
         Open 

 
    Closed Hours Counts 

            Date Time Date Time Opened Reported Daily Cum Daily Cum Daily Cum Daily Cum Daily Cum Daily Cum 
        0.0                           
        0.0                           
        0.0                           
        0.0                           

total       0.0                           
        0.0                           
        0.0                           
        0.0                           
        0.0                           

total       0.0                           
        0.0                           
        0.0                           
        0.0                           
        0.0                           

total       0.0                           
        0.0                           
        0.0                           
        0.0                           
        0.0                           

total       0.0                           
    0.0              
    0.0              
    0.0              
    0.0              

total    0.0              
Figure B1-3.–Fish wheel spreadsheet linked to the data summary (Datsum). 
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Figure B1-4.–Datsum example used to summarize daily escapement estimates.  Adjusted sonar and fish wheel data is linked to this spreadsheet. 
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Wireless Network (As prepared by April Faulkner) 
1. We are currently using wireless connections at the Kenai and Kasilof sonar sites.  The 

description provided here pertains to Kasilof but is not much different from the way the 
Kenai is set up.   

2. Username: admin Password: sonar 
3. Kasilof IP address:  North Bank=128.95.97.1    South Bank = 128.95.97.2 
4. Need to add IP address for Kenai. 
5. Mount the wireless units on each bank and point them toward each other by using line of 

sight; finer adjustments can be made after they are connected to a computer.  During 
initial setup connect both units to a computer and verify that both are working before 
plugging the Kasilof SB/Kenai NB wireless into the DIDSON.  For each unit connect the 
100ft black Ethernet cable to the PoE connector on the unit and the Output connection on 
the black power box.  Connect the shorter Ethernet cable to the port labeled Input on the 
power box and the Ethernet port on the computer. Plug in the black box to power unit.  
Plug in the black box to power up unit. 

6. To communicate with the wireless unit open the Internet Explorer and in the address bar 
type in the IP address of the unit and press Enter.  The SMC login window should appear, 
then enter the user name (admin) and password (sonar) and click Login.  Under 
Advanced Setup > TCP/IP Settings the menu should appear as below. The IP addresses 
of the computer, DIDSON, and wireless should have the same numbers except for the last 
number. (Example: computer = 128.95.97.101, DIDSON = 128.95.97.227, wireless = 
128.95.97.1)  
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7. Under Advanced Setup > RSSI > 802.11a Interface > the RSSI Value is the signal 
strength.  When aligning the 2 units try to get this value as high as possible.  A value >30 
is a good connection.  The Link lights on the back of the wireless unit will also give you 
an indication of the signal strength between the units. 

 
8. After both wireless units are confirmed to be working and a connection is established 

between the 2, open the DIDSON program on the NB and SB computers.  On the Kasilof 
SB (or Kenai NB), unplug the Ethernet cable from the Input port on the wireless black 
box and plug it into the DIDSON.  Establish a DIDSON connection on the computer first 
then unplug the Ethernet cable from the computer and plug it into the Input port on the 
wireless black box.  The DIDSON signal should now be transmitting to the opposite bank 
computer and appear on the opened DIDSON program.  Turn off computer on the Kasilof 
SB (Kenai NB).  On the (Kasilof) NB, the DIDSON frame rate should be at least 7 
frames per second (fps) on the high frequency mode and between 3–5 fps on the low 
frequency mode.  Link speed under network connections should be 10mbps full.  The 
DIDSON Ethernet mode should be checked by Frame Request 
(Sonar>Configure>Ethernet Transfer Mode>by Frame Request). 

Wireless Troubleshooting 
1. If there are problems establishing a connection on the NB, make sure the DIDSON 

program is not in demo mode.  Reduce the frame rate to 1 during the initial connection so 
it is easier for the wireless connection to keep up.  Then gradually increase the frame rate 
to normal speed.  

2. Recycle power on the DIDSON by getting the DIDSON connected on the SB computer 
first then resending the signal over to NB.  Turn on the SB computer, open the DIDSON 
program, remove the Ethernet cable from the Input port on the wireless black box, plug it 
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into the computer, and wait for it to connect.  It will take a minute, may have to close 
program and reopen. If it doesn’t work then recycle the DIDSON power. 

3. Check signal strength.   
4. Check the power and link lights on the back of the wireless unit.  Top right light is the 

power and should be on; bottom right light is the link and it should be on and possibly 
blinking; bottom lights to the left of the link light are the 11a signal strength and there 
should be at least one lit up. 

5. Check signal strength in dB:  Internet Explorer Browser / in address bar type in 
128.95.97.1/ (NB) or 128.95.97.2 (SB) and hit enter. In the SMC window type in the 
username; (admin) and the password (sonar).  Go to Advanced / RSSI / check signal 
strength of the 802a.11 radio.  Ideally should be above 30 dB, but we have seen it often at 
26 dB.  Look at Noise Ambience, should be a large negative number, i.e., -98 dB. 

6. To increase signal strength, move the wireless unit to line up with the unit on the opposite 
bank.   

7. Refresh the signal strength value after moving by clicking on RSSI. 
8. If unable to establish a wireless connection to the NB, then turn on the SB computer and 

set up for regular sampling as same as the NB DIDSON and save data to the computer or 
an external drive.  (Call for help) 

DIDSON Maintenance 

1. Silt will accumulate inside the lens housing.  To clean: 

2. Select a time when the DIDSON will not be recording-remember that cleaning takes 
about 10 minutes so allow for 15 minutes cleaning time. After shutting down the 
DIDSON (do so when there is adequate time between recordings), tilt the DIDSON out 
of the water then remove the 4 tiny Philips screws from the top of the housing.  Keep 
spares on hand. 

3. Lift the cover straight up. 

4. Clean the lens with water using a soft bristle brush or wet cloth.  DO NOT scratch or use 
alcohol to clean.   

5. Replace housing and do not over-tighten screws!  Do not tighten gasket to less than 90% 
uncompressed thickness.  Clean area around the array too. 

6. Restart DIDSON as per instructions above.   

7. Use 3M Silicone Lubricant to maintain all connectors prior to and after the season. 

DIDSON Troubleshooting  
1. If DIDSON is not connecting:   
2. Make sure the program is not in Demo Mode.  Edit>Mode>uncheck Demo Mode. 

3. The Ethernet transfer mode should be by frame request.  Sonar>Configure>Ethernet 
Transfer Mode>check by Frame Request. 

4. Make sure parameters and IP address in Didson.ini file (Edit>Sonar>Didson.ini File) are 
correct.  Didson IP = 128.95.97.227, netmask = 255.255.255.0 
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5. Check IP address on Computer (Control Panel>Network Connections>Local Area 
Connection>Internet Protocol>Properties).  Should obtain automatically or type in 
128.95.97.100 for IP & 255.255.255.0 for netmask 

6. Check all connections inside and outside and reset.   

7. Plug monitor into topside box and to see if sonar is booting up.  Will help narrow down 
problem to sonar or computer.  The sonar boot up process is also shown and the address it 
is trying to connect to. 

8. Close down program and recycle topside power.  Reopen program to see if it connects.  
Sometimes it is good to completely shut down computer and start over. 

9. If the sensor malfunctions there is no need to repair immediately.  As long as the 
DIDSON is recording properly and a visual image confirms proper aim, the lack of a 
sensor won’t inhibit operations. 

Shut Down 
1. Close the DIDSON program by clicking the X in the upper right, then 

2. Click the ‘hidden icons’ arrow (bottom right of screen),  

3. Click the image that looks like a floppy disk in lower right corner.   

4. Click on the message that appears and the external hard drive will close or shut down.  
When a “safe to disconnect…” message appears then turn off the external hard drive and 
disconnect the firewire.  THE EXTERNAL DRIVE MUST BE CLOSED OUT THIS 
WAY TO AVOID ANY DAMAGE. 

5. Right click green arrow icon on bottom bar of screen, click safely remove hardware, 
select Model US 485TB (com 5) and stop. 

6. Unplug USB from computer   

7. Turn off the DIDSON 

8. Turn off the power switch 

9. Turn off the generator 

Daily Duties 
First thing every shift, each crew member must:  

1. Examine the transducer mount to ensure that transducers are always upright, submerged 
and free of debris.  REMOVE any debris ASAP. Check weirs too. 

2. To ensure that the DIDSON program is running and that files are being recorded to the 
DIDSON file, go to Windows Explorer; C:/Kasilof/ DIDSON/Data & Image files and 
find the date of interest – if not found, see DIDSON troubleshooting section below.  

3. Be sure the red lights on the Bendix are flashing alternately or in unison, depending on 
beam mode, and the printer is functioning properly. 

4. Check the DIDSON sensor readings (either in the DIDSON or Zagi33 program). Record 
the pitch/tilt (Y) and roll(X); if different from the prior entry by more than 0.5 pitch, or 
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1.0 roll recheck transducer mount.  Return the aim to previous setting. Early morning 
shift, or after midnight, create a new sensor log file (see below). 

5. Keep the daily log updated. 

6. Record times of data copying.  

7. Changes in transducer and weir position.  

8. Document any problems and solutions-including the exact time when they occurred if 
possible, and any other pertinent information 

9. Call in daily totals to the 260-2917 and leave a message any time after midnight, or call 
in daily total and updates at 0900.  Call in updates at 1200 and 1500 when required.  
When calling in numbers to the office, always speak clearly and not too fast and include: 

a. Total daily escapement numbers by bank 
b. Daily cumulative numbers.   
c. Fish wheel hours fished, catch by species (report 0 even if it is zero fish) and bank.  
d. Hourly fish passage rate 
e. And anything that needs immediate action 

10. Call- in recordings should be something similar to this and in this order: 
a. “This is Joe Biologist calling from the ______ River for ______ (date).  Total count 

for the north bank (always give north bank counts first) is ______ fish; the south 
bank count is _____ fish for a daily cum of _____ fish.  That brings the cum total for 
the season to ______ fish.  (Report total number of fish, do not report the estimates 
by species…apportionment will be done in the office.)  The fish wheel ran for ___ 
hours and caught ____ sockeye, ___pinks, __ chum, __ coho and __ chinook (report 
in that order).  If the catch for a species is 0, say 0 or simply say there were no other 
species in the fish wheel.”    Report catches of Dolly Varden if requested.  If there is 
something urgent that needs to be reported, do so as briefly as possible...do not 
ramble about things that can wait (not interested in listening to a recording about 
cleaning the weir or needing to buy waders…that can be discussed between 0900 and 
0930, when the project leader calls each of the 4 sonar sites for a brief update of 
activities).   

11. Other duties include:   
a. Clean all weirs every day at least once each shift.  Check the image on the computer 

screen, a fuzzy or dark image along the edges could mean too much silt on the lens.  
Kenai and Kasilof should be cleaned once a week or sooner if needed. 

b. Check water temperature and adjust sound speed at 10:00 and 20:00. 
c. Check free space on computer and empty recycle bin if space is needed. 
d. Record environmental data twice daily at Kenai and Kasilof.   
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Appendix C 1.–Fish wheel operation and sampling procedures. 

Fish Wheel Assembly 
At all sites except the Kasilof River, the fish wheel floats are stored already assembled on the 
river bank.  

1. All fish wheel parts, including nuts and bolts, should be stored with the floats and never       
 separated.   

2. Three to four people are needed for assembly. 

3. Tools: ¾” and 9/16” wrenches and sockets (2–3 sets), poker bars (two), sledgehammer, 
pliers, wire, wire cutters and electricians tape, plus, extra nuts and bolts. 

4. Push floats into the river first, then, install front and back walkways.  Tie floats assembly 
to  shore. 

5.  Bolt the axle to the stanchions (mount both plates in the top holes of the stanchion).  
Stanchions that support the axle are permanently attached to the floats with one axle 
mounting plate already in place; while the other mounting plate is attached to the axle.  The 
mounting plate has one central hole and four small holes to accommodate the end of the axle. 

6.  Install both baskets (opposite each other) and one paddle on the axle.  Upstream basket 
will scoop  down, while the downstream basket will scoop up. 

7.  Secure the baskets and paddle with cables equipped with a turnbuckle on one end and a 
shackle on the other.  The cables attach to brackets on the side of each basket and paddle and 
should be tightened just enough to take out some, but not all of the slack.   

8.  Bolt live-box supports (2, 4” aluminum channel approximately 4 ft long) to the off shore 
float. 

9.  Tow the fish wheel to where it will operate for the summer.  Secure the baskets/axle to 
prevent rotation while in transit. 

10. Attach upstream and downstream anchor booms.  Attach two upstream anchor ropes.  
Secure ropes upstream to anchors or trees on shore.  Push the fish wheel offshore and 
position parallel to shore and where water depth will allow the baskets and paddles to turn 
without bumping the river bottom. 

11. Check depth by taking a piece of conduit approximately 10 ft long and measure the depth 
at the near shore side of the axle, bottom to axle.  Mark the depth on the conduit and compare 
the  distance between the axle and basket.  The depth should be 2–4” greater than the distance 
between the axle and basket.  Some adjustment may need to be made once everything is in 
place.  Temporarily anchor the booms to shore with re-bar but do not drive too deep. 

12. When water depth is adequate to spin the baskets, insert the second paddle into the axle 
and attach remaining cables to the baskets/paddle.  Tighten all cables by adjusting the 
turnbuckles and attach wire to the turnbuckles to keep them from loosening when the axle 
spins. 

13. Because the live box is heavy and awkward it should be installed from a boat.  Tie a 
safety line  from the top of the box to the fish wheel.  Tip the box on its side, bottom facing 
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the fish wheel, ease over the side of the boat while rotating the bottom down and between the 
two channel supports. Bolt in place. 

14. Install fish slide and fish guard.  Spin the axle to test for an optimum rotation speed of 3–
5  rotations per minute. 

15. Double check anchor ropes and boom re-bar. 

16. Position weir frame or tripod between the fish wheel, slightly downstream of the axle, 
and shore.  It is also acceptable to position the weir frame at the downstream end of the float 
and extend it past the float toward mid river by one meter.  Insert 1” x 10’ electrical conduit 
pipe into the weir  frame to form a “fish tight” structure to divert fish toward fish wheel 
baskets. 

17. Install walkways to shore if necessary. 

18. Adjust the fishing depth of the baskets to compensate for change in water levels to 
maintain the baskets 2–4 inches off the river bottom.  This will prevent fish from swimming 
under the baskets.  Adjust fishing depth by removing the fish slide and attach stanchion 
winches on each of the axle plates by connecting the winch cable to the shackle hole on top 
of each plate.  Unbolt the plates  on both sides of the axle and raise or lower the appropriate 
height using winches.  Re-insert bolts and test spin the baskets.  A person’s body weight may 
drop the fish wheel enough to push the basket into the bottom so it may be necessary to step 
off the fish wheel when testing the spin. 

18. Accurately record fish wheel openings, closures and catches. 

Sample size 
1. Sampling strategies reflect different sample sizes necessary to achieve the ASL databases 
for  each river. 

2.  Sampling goals are subject to change and should be confirmed before operations begin 
each year. 

3.  Kenai River goal: 

 0.1% of the previous day’s escapement; 500 total samples/500,000 fish. 
4.  Kasilof River goal: 

 0.2% of the previous day’s escapement; 500 total samples/250,000 fish. 

ASL (Age, Sex and Length) sampling 
1.  Crews from the catch and escapement project will collect salmon samples and data from 
the  Kenai and Kasilof fish wheels.  Yentna sonar crews will perform ASL sampling. 

2.  Catch and escapement crews and sonar crews will accurately communicate fish wheel 
data daily.  The sonar crews will enter catch data in the Fish Wheel Catch Summary (Figure 
B1-3). 

3.  Sockeye salmon ASL data will be collected for all three rivers.  Additionally, ASL data 
from other species may be collected and when necessary, genetic samples.   

4.  The project leader for catch and escapement will analyze all ASL data providing 
management and  research biologists with:  
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 Age composition of each stock 
 Productivity of each system 
 Growth analysis 
 Escapement goals 
 Forecasting run strengths and future returns 

5.  Information should be recorded in ‘Rite in the Rain’ (waterproof) data sheets. 

6. Fish wheel sampling will begin as soon as the fish wheels are operational. 

7.  ASL data sheets from remote sonar sites (if in operation) will be flown into the ADF&G 
office on weekly supply flights to initiate stock analysis (age composition) in a timely 
manner. 

8.  After the required number of ASL samples is obtained, any remaining fish should be 
identified by species, counted and released with catch numbers recorded on the Fish Wheel 
Summary sheet.   

Sampling procedures 
1.  Use the ASL data form when sampling fish from the fish wheel (Figure C1-1).  The age 
column will remain blank and filled in later when the scales are aged. 

2.  Identify sex and species; count each sockeye salmon to be sampled. 

 Males usually have the beginnings of a hooked snout and slimmer stomach region 
than the female.  When the female is squeezed or pressed, often an ovipositor will 
protrude from the anus. 

3.  Measure length (millimeters) from the middle of the eye to the fork of the tail (MEFT).   
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Figure C1-1.–Fish wheel ASL sampling form. 

4.  Pull the ‘preferred scale’ from the fish using forceps.  The preferred scale is located on 
the left side of the fish, 2–3 rows above the lateral line on a diagonal line from the posterior 
of the dorsal fin to the anterior of the anal fin.  Remove all slime, grit and skin from the scale 
by moistening and rubbing between fingers (Figure C1-2). 

Upper Cook Inlet Adult Salmon Age-Length Form
LOCATION: CARD #:
DATE: SAMPLERS:

START TIME: END TIME:
Age

No. Sex Length Genetics # Otolith Scale
1 COMMENTS:
2
3
4
5
6
7
8
9
10
11
12
13
14
15 Fishwheel Information Totals
16
17 Reds Sampled:       ________
18
19
20 Reds Not Sampled:       ________
21
22
23
24
25
26 REDS GRAND TOTAL       ________
27
28 Incidental Catch:
29
30   Kings:
31   Pinks:
32   Dollies:
33   Chums:
34   Silvers:
35   Other:
36
37 Time fishwheel started:__________
38
39 Time fishwheel stopped:__________
40

Sex: 1-male 2-female
Length: mid eye to fork-of-tail in nearest mm.
Genetic # - vial number if sample is taken.
Otolith - Y=yes filename:  12alform.xls
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Figure C1-2.–Scale procedure showing the preferred area. 

5.  If the preferred area is scarred and scales are missing, select a scale within the preferred 
area on either the left side of the fish or pull a scale from an area 1–2” anterior of the 
preferred area.  

6.  If no scales are present in the preferred area on either side of the fish and sufficient 
numbers of fish are available for sampling, disregard fish. 

7.  Mount the cleaned and moistened scale on a gum card directly over the appropriate 
number (Figure C1-3).  All scales should be oriented the same direction on the gum card.   

 The side of the scale facing up on the gum card is the same as the side facing up 
when pulled from the fish.  This outward facing side is referred to as the 
‘sculptured’ side and is necessary to leave an impression on an acetate card when 
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‘reading’ (aging) the scale.  Sculptured ridges may be felt with a fingernail or 
forceps. 

                      

  Species:         
Card 
No:          

  Locality:_________________________________________________________ 

  Stat. Code:_______________________________________________________ 

  Sampling Date: Mo______________ Day________ Year________________ 

  Gear:___________________________________________________________ 

  Collector(s):______________________________________________________ 

  Remarks:                   

                      

                      

                        
                        
  10 9 8 7 6 5 4 3 2 1   
                        
  20 19 18 17 16 15 14 13 12 11   
                        
  30 29 28 27 26 25 24 23 22 21   
                        
  40 39 38 37 36 35 34 33 32 31   

                        
Figure C1-3.–Gum card, front (top) and back (bottom), used for scales samples. 

Scale Cards 
1.  Each card is sequentially labeled from day to day.  Each scale card has space for 40 scale 

samples that must match the No. on the ASL form.   

 If a card for sockeye salmon was No. 10 on July 12, start with card 11 on July 13, 
or, if card 10 is filled while sampling and sampling is to continue, label the next 
card 11, etc. 

2. If scale samples are collected from other species, numbering sequence should be 
independent of the sockeye numbering sequence. 

3.  Headings of scale cards and ASL sheets should be filled out with #2 pencils with 
appropriate information prior to sampling. 

 Species: common name (sockeye) will suffice.  Specie codes are; Chinook-41, 
sockeye-42, coho-43, pink-44 and chum-45. 

 Card No. as stated above, sequential by river. 
 Locality: name of river and bank. 
 Gear: fish wheel. 
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 Collector: Last name of persons collecting scales and data.  Note the scale 
collector with SC, the wrestler with W and if a third person records data, initialize 
with an R. 

 Notes: any information pertinent to sampling such as weather conditions or 
problems. 

4.  Keep the card dry so that scales remain affixed in the proper place. 

5.  Cover the completed, dry, gum card with wax paper, clip to the ASL form and keep dry. 

Materials for sampling 

 Clipboard 
 Gum cards 
 Wax paper 
 Gloves for handling the fish 
 ASL rite-in-rain data sheets 
 Measuring board 
 Pencils 
 Forceps 
 Dip net 
 Rain gear 
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APPENDIX D: GENETIC SAMPLE COLLECTION 

PROCEDURES 
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Appendix D 1.–Salmon Genetic Sampling. 

Salmon Genetics  
Sampling Non-lethal Finfish Tissue for DNA Analysis 

ADF&G Gene Conservation Lab, Anchorage 

I. General Information

We use axillary process samples from individual fish to determine the genetic characteristics and 
profile of a particular run or stock of fish. This is a non-lethal method of collecting tissue 
samples from adult fish for genetic analysis. The most important thing to remember in collecting 
samples is that only quality tissue samples give quality results.  If sampling from carcasses: 
tissues need to be as “fresh” and as cold as possible and recently moribund, do not sample from 
fungal fins.  

Sample preservative: Ethanol (ETOH) preserves tissues for later DNA extraction without having 
to store frozen tissues. Avoid extended contact with skin.  

II. Sample procedure:

1. Tissue type: Axillary process, clip axillary process from each fish (see attached print
out).

2. Data to record: Record each vial number to paired data information.
3. Prior to sampling, fill the tubes half way with ETOH from the squirt bottle.  Fill only the

tubes that you will use for a particular sampling period.
4. To avoid any excess water or fish slime in the vial, wipe the axillary process dry prior to

sampling. Using the dog toe nail clipper or scissors, clip off axillary process (1/2 -1”
max) to fit into the cryovial.

5. Place axillary process into ETOH. The tissue/ethanol ratio should be slightly less than
1:3 to thoroughly soak the tissue in the buffer.

6. Top up tubes with ETOH and screw cap on securely.  Invert tube twice to mix ETOH and
tissue. Periodically, wipe the dog toe nail clippers or scissor blade so not to cross
contaminate samples.

7. Discard remaining ethanol from the 500ml bottle before returning samples. Tissue
samples must remain in 2ml ethanol after sampling.  HAZ-MAT paperwork will be
required for return shipment. Store vials containing tissues at cool or room temperature,
away from heat in the white sample boxes provided.  In the field: keep samples out of
direct sun, rain and store capped vials in a dry, cool location.  Freezing not required.

III. Supplies included with sampling kit:

1. (1) – Dog toe nail clipper - used for cutting the axillary process
2. (1) – Scissors can be used to cut a portion axillary process – if clippers don’t work for

your crew
3. Cryovial- a small (2ml) plastic vial, pre-labeled.
4. Caps – with or without gasket to prevent evaporation of ETOH.
5. Cryovial rack- white plastic rack with holes for holding cryovials while sampling
6. Ethanol (ETOH) – in (2) 500 ml plus (1) – 125 ml Nalgen bottle
7. Squirt bottle – to fill or “top off” each cryovial with ETOH
8. Paper towels – use to blot any excess water or fish slime off axillary process
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9. Printout of sampling instructions  
10. (3) – three pair of lab gloves (size large) 
11.  Laminated “return address” label 

 

IV. Shipping: HAZMAT paperwork is required for return shipment of these samples and is 
included in the kit. 

Ship samples to:    ADF&G – Genetics                                   Lab staff:     1-907-267-2247                                            

  333 Raspberry Road                                  Judy Berger: 1-907-267-2175 
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Figure D1-1.–Axillary process location above the pelvic fin. 
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Appendix E 1.–Crew scheduling, timesheet procedures and general crew concerns. 

Timesheets and schedules 
1.  Standard field timesheets are kept and signed by each employee and submitted to the area 

office  (Soldotna) by the 15th and 30th or 31st of each month (Figure E1-1). 

2.  Employees are responsible for working 37.5 hours each week and documenting the start 
and stop times.   

 
Figure E1-1.–Standard Field Timesheet. 

3.  If access to online services is available, crews will enter their hours in the ADF&G 
Timesheet Entry and Reporting System (TEARS).  An ID password will be needed to login to 
TEARS, see administrative staff for assistance. 

 After accessing the program, click the appropriate time period to access the pay 
period screen. 

ALASKA DEPARTMENT OF FISH AND GAME  Time and Attendance Report 
Pay period ending: 7/15/2003 SSN: 123-45-6789 Name: Stan  Doe Divisio

n   Commercial Fisheries 
Record times in military format.  Example: 6:00 p.m. = 18:00.   If you work past midnight, stop at 23:59 and resume at 00:01 the next day. 

Day Date Start Sto
p Start Sto

p Start Sto
p Start Sto

p Start Sto
p Leave Taken Sea 

Duty Standb
y Hazard Code 1 Code 2 Code 3 Code 4 Holiday /  

Leav
e 

Work 
Hrs  Total 

Mon 7/1 8:00 12:00 13:00 16:30 7.50 0.00 7.50 
Tues 7/2 8:00 12:00 13:00 16:30 7.50 0.00 7.50 
Wed 7/3 8:00 12:00 13:00 16:30 7.50 0.00 7.50 
Thurs 7/4 H 7.50 0.00 7.50 0.00 
Fri 7/5 A 7.50 0.00 7.50 0.00 
Sat 7/6 off 0.00 0.00 
Sun 7/7 off 0.00 0.00 
Mon. 7/8 8:00 12:00 13:00 15:30 6.50 0.00 6.50 
Tues 7/9 8:00 12:00 13:00 15:30 6.50 0.00 6.50 
Wed 7/10 13:00 17:00 18:00 21:30 7.50 0.00 7.50 
Thurs 7/11 13:00 17:00 18:00 21:30 7.50 0.00 7.50 
Fri 7/12 13:00 17:00 18:00 21:30 7.50 0.00 7.50 
Sat 7/13 13:00 17:00 18:00 21:30 7.50 0.00 7.50 
Sun 7/14 off 0.00 0.00 
Mon. 7/15 7:00 12:00 13:00 16:00 8.00 0.00 8.00 

0.00 0.00 0.00 
TOTALS 0.00 0.00 73.50 0.00 0.00 0.00 15.00 73.50 

Comments Comments 
Charge to: 7/1 7/9 

Notation CC/LC % 7/2 7/10 
1 100% 7/3 7/11 
2 

  7/4 holiday 7/12 
3 

  7/5 annual lv 7/13 
4 

  7/6 regular day off 7/14 regular day off 
Total 100% 7/7 regular day off 7/15 

7/8 
We certify that the information provided above is true and 
correct. 

Date
: **Codes Hours CC/LC 

Employee's Signature 

Date
: Supervisor's Signature 

Date
: 

Leave &   
Holiday 15.00 

Approving  Officer Signature 

11100821-11128351 
  

Holiday, Leave, Overtime and  

No code needed for Leave & Holiday  

 

 

 

 

Premium Pay Overrides 

 

7/15/2003 
              Leave Use Codes 
  H=Holiday              X=Comp 
Ann   S=Sick                      Y=Comp 
Pers   A=Annual               C=Court 
  P=Personal            L=LWOP 

      ** Premium Pay Codes (PPC) 
110 - Sea Duty          250 - Straight Time 
206 - Hazard               251 - Overtime 
211 - Standby 
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 Enter the hours for each day of work by going to the Edit section and recording 
hours and proper code.  However, if a routine work week was followed, click 
default, which will automatically enter 7.5 hour days for the pay period. 

 Close the window, check the hours for each day then save the timesheet, submit, 
and print a copy for Admin.  Once the timesheet is submitted all the entries are 
locked into place, changes cannot be made without calling Admin to unlock the 
sheet. 

4.  Regular Time: The workweek begins on Monday at 00:00 and concludes 23:59 the 
following Sunday, consisting of 37.5 hours.   

5. A 5-day workweek will be scheduled for the Kenai and Kasilof crews with each shift 
consisting of 8.0–8.5 hours (7.5 hours plus a ½ or 1-hour lunch). 

6.  If in operation, Yentna River crews will be scheduled to work staggered 6 hour shifts, 7 
days a week during standard sonar operations.  Additional hours will be worked when river 
conditions necessitate the moving of sonar and fish wheel equipment or to  respond to equipment 
breakdowns that need immediate attention. 

7. Overtime: The need to work overtime (OT) will be evaluated by the project leader or 
crew leader if the project leader is absent. 

 Employees receive OT pay (1.5 times regular pay) for any hours worked in excess 
of 37.5 hours but no more than 15 hours can be worked in any 24-hour period. 

8. Shift differential: Any employee whose work shift starts after 12:00 is eligible for shift 
 differential pay.  Shift differential eligibility is based on start time. 

 Swing shift starts at 12:00 and ends at 19:59. 
 Graveyard shift starts at 20:00 and goes until 07:59. 

9.   Hazard duty:  For eligible employees, hazardous working conditions are described in the 
Manual of Administrative Procedures. Hazard duty must be properly documented on timesheets. 

10. Holiday: Those employees who work on a State or Federal holiday are eligible for 
holiday pay. 

11. During the sonar operational period, the crew leader at each site makes the schedule at 
least one week (more if desirable) in advance, reviews it with employees and ensures that most 
of the workday or period is covered.  Every employee is required to be given two days off, back 
to back, but exceptions may be made where time off is impractical. 

12. Routines may vary from site to site, however essential duties must be completed by 
certain times.   

 ASL sampling as required. 
 Daily escapement estimates must be completed and error checked by 09:00.  

These estimates are for the previous day’s counts. 
 Daily escapement estimates must be phoned into the project leader by 09:00. 
 During the course of the season for Kenai and Kasilof rivers, Area Managers may 

want updates throughout the day. Cumulative estimates through 00:00–07:00; 
00:00–12:00; and 00:00–15:00, rounded to the nearest 1,000th fish.  Include 
passage rate information. 
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Field logistics 
1.  Remote sonar sites, if operating, are supplied once a week with groceries and necessary 

 maintenance needs.  The crew leader and the air charter determine a consistent weekly 
schedule.   

2. Field crew leaders will relay supply needs to the designated logistics coordinator for 
Upper Cook Inlet field camps. The logistics coordinator and/or crew leader at the Kenai sonar 
site will ensure that weekly supplies are delivered to the specified air charter on schedule.  In the 
absence of a logistics coordinator, a crew member from the Kenai sonar site will fulfill this role.  

3. High Adventure Air or Litzen Air are suggested air charter services to use for weekly 
supply  needs to remote sonar locations.  DeHaviland Beavers on floats are used for larger supply 
needs,  while super cubs are useful for small grocery runs.  

Communications and phone use 
1. Remote field camp communication devices:  

 The crew leader or designated staff is required to call in daily to relay sonar camp 
welfare, data, camp needs and/or personnel needs.  A specific time will be arranged 
with the project leader. 

 In general, personal cell phones do not work at remote field camps.  It is justifiable to 
use the State’s communication devices for personal needs.  Justifiable phone calls 
include but may not be limited to paying bills; inquiries about school issues; mail; 
laundry; safety checks with family; health; etc.  Personal phone calls should be kept 
to a minimum of 5 minutes. 

 Lengthy “social” conversations (>5 minutes) are allowed but must be paid by the 
caller, limited to off hours and less than 20 minutes per day.  A record must be kept of 
these calls. 

2. Land line (Kenai sonar site):  

 Available for personal use during off hours and breaks only as long as the call is not 
long distance. 

 Extended personal calls must be made in the evening only, not during normal office 
hours. 

 This land line number may be given to businesses and personnel related activities. 
3. Use of state cell phones at Kenai and Kasilof sonar sites: 

 The crew leader or designated staff is required to call in daily to relay sonar site 
welfare, data, camp needs and/or personnel needs.  A specific time will be arranged 
with the project leader. 

  Periodic escapement updates may also be required by area management biologists.  
Times for these updates will arranged as needed. 

 Cell phone numbers may not be given out to the general public.  These phones are 
only for ADF&G staff communication.  

 When reasonable, cell phones should be carried on person during working hours. 
4. Personal cell phone use: 

 Should only be used during breaks. 
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 Should not be carried on person during working hours. 

Crew courtesies and expectations 
1.  Show respect for coworkers.   

2. Make an effort to help and train new employees.  Be patient, so that everyone has a 
chance to improve their performance and become a team player. 

3.  Good work habits.   

 Be on time. 
 Take the initiative to get each task done. 
 Look for things to do-don’t wait to be told. 
 Show an interest in your work.  A positive outlook will increase your performance 

and a general appreciation of your job.  There is an element of fun in each task to be 
done. 

4. Pets remain at home. 
 Pets will not be tolerated inside the Kenai sonar site facilities. 
 The state is not responsible for the transportation or health of employee’s pets. 

5. Kenai sonar site. 
 ADF&G staff may request housing at the Kenai sonar site, if space is available.   
 Housing is available during regular seasonal projects only; long-term winter 

housing is not available.   
 House rules must be followed exactly; failure to do so may result in immediate 

expulsion. 
 Must clean up common areas after yourself; laundry, dishes, bathroom, 

refrigerator. 
 Must clean up your room when you check out. 
 No pets. 
 No smoking in the trailer 

 

Common phone numbers 
1. Bill Glick (Project Leader)    260-2917 Cell 398-3002 

2.   Mark Willette (UCI Research Project Leader)     260-2911 Cell 394-2217 

3. April Faulkner      260-2907 Cell 953-1199 

 (DIDSON questions) 

4. Suzi Maxwell      260-2914 

 (DIDSON questions) 

5. Main Soldotna office     262-9368 

6. Constance Nicks     260-2902 

 (Personnel questions) 

7. Kenai sonar site     262-4267 



  

58 

 

8. Kasilof sonar site     394-0029 

9. Wendy Gist      260-2933 Cell 953-9474 

 (ASL sampling) 

10. Pat Shields  

 (Area Management biologist)    260-2941 Cell 398-1254 

11. Aaron Dupuis  

 (Assistant Area Management biologist)  260-2916 Cell 347-3020 

12. Kim Rudge-Karic 

 (Logistic coordinator and supplies)   260-2924 Cell 420-7072 

13. Additional staff and numbers of pertinent businesses will be available annually. 

14. Emergencies 

 911 
 State emergency; provide location; extent of injuries; access point. 
 State Troopers in Soldotna   262-4453 
 State Troopers in Anchorage   269-5511 
 F&W Protection     262-4573 


	LIST OF TABLES
	LIST OF FIGURES
	LIST OF APPENDICES
	Purpose
	Objectives
	Methods
	Field Operations
	Acoustic Sampling
	Fish Wheel Sampling
	Age, Sex and Length Sampling
	Climatological Data Collection
	Stream Surveys

	Data Analysis
	Estimating Total Fish Passage
	Estimating Missing Data
	Estimating Salmon Species Composition
	Variance of Sockeye Passage Estimates
	Evaluation of Observer Variability


	Schedule and Deliverables
	Responsibilities
	References Cited
	APPENDIX A: DIDSON Connections
	APPENDIX B: DIDSON Operation and Daily Procedures
	APPENDIX C: Fish wheel Operation and Procedures
	APPENDIX D: Genetic Sample Collection Procedures
	APPENDIX E: Crew Concerns



